Anutoupyoc: Evotpatia AtakortouAou, SEE MMAnpoopikr¢ MEKES NeAomovvroou, NoéuBptoc 2020

Z0yxpovn €§ Anootaoswg Eknaidsvon pe to Webex Meetings

+ Xpron and eKMASeUTIKO
Eyypadn otov Siktuakd tomo https://webex.sch.gr/ e Tov atopiko Aoyaplacuo MNzA.

Mpoteivetal n eykataotacn Tou Aoylopikol Webex Meetings otov umoAoyLoTh Kat h
SbaokaAioc pe xpron Ttou Aoywopkol. [Av o (Sto¢c umoAoyiotric/Aoytoutko
xpnouuormoleital kat and aAlov ekmaldSeUTIKO, o KABs evalhayr XPrHoTtn TPETEL va
yivetal sign out amoé tov mponyoluevo (BA.clkova) Kal sign in pe Aoyoplacud MNIA
EMOUEVOU EKTTALSEVUTIKOU]

+ Xprion and padnti/TpLa
O tpoémoc Ue tov omoio cuvdéctor o/n padntig/tpla emnpedlel KABOPLOTIKA TIC
SuvatoTnNTEC TTOU EXEL yia OAEC TIC AELTOUPYIEC TTOU TtEPLYPADOVTOL OTLC ETTOUEVEC

oeAISEC (ekTOC amod TG BaolkEG Aettoupyieg Tix. UIKpOdwvo-chat Ttou eival epIKTEG o€
KABe TpoMO ocUlVdeONG).

Juvndwe mpoteivetat/mpotiudaral ouvvdean uéow QUAAOUETPNTH 1) UECW KLVNTIG
oUoKeUr¢. Qotooo, mANpeic Suvatotntes os padntr/tpta Sivovratl kata tn ovvdeon
18: ano untoAoytotn ue sykataotaon Aoyiouikou Webex Meetings.

1° tpbdnog. >UvSeon and unohoyioth

a) pe xpron @uAhopetpntri(browser) Kata tn ouvdeon {nteital OVOUATEMWVULO
kot email. Mpémnet va Sivetar to aAndvo ovouatemwvuuo ywo vo gudaviletol
OWOTA OTouC Jupuetéxovieg(Participants) tou pabnuatog. To email elval
TIPOOLPETLKO. MTopel va pelvel Kevo 1) va 50Bel omolodnmote uMapKTO R UN.

B) 1e eykatdotoon tou Aoylopkol Webex Meetings.

2% tpdémog. TUvdeon amd Kwnth ouckeun (tablet ) kwnté tnAédwvo) Me

gykataotaon/xpAaon app. la va yivet n ouvbeon xpelaletat o oUVSECLOC TNC
aifouoac ekmaldeutikou n o avriotolyo¢ 9Yneilo¢ aptdudc tng aifouvoac.
Znteital  ovopotemwvupo kot email. Mpémet va Sivetot 1O aAnBwo
OVOULOTEMWVUHO yla va epdaviletal ocwotd otoug Tuppetexovieg(Participants)
Tou paBnuatog. To email gival unmoxpewtikd. Mmopel va SoBel omolobnmote
UTTOPKTO 1 .

3% tpénog. Tnhedwvikh olvdeon amd otabepd tnAépwvo. Mpoteivetal povo

otav dev eival edkty aA\n Avon. Ta va emiteuxBel xpeldletol emkowvwvia
EKTTALSEUTIKOU-HaONT Kal KAtAAANAeC puBuioelg. Katd tnv thAedwvikn olvdeon
o/n nadntrg/tpLla HOVo aKoUEL TO Hadnua.
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e OAn tn Slapkela tou pobrpotog (kal katd To Slapolpacuo tng obovng) eival
XPNOLUOo va elval avolyto to mapabupo Tuppetéxovreg(Participants) mpokelpuévou o/n
ekTaLSeUTIKOC va propei va kdvel Admit ywo poOntég/tpleg mou site sloépyovral
KaBuotepnuéva eite gixav TEXVIKO TPOPBANUA Kal cuvSEovTtal ek VEOU.

+ MNapoucis¢-Tavtonoinon
Me tnv gicodo kaBe padntr/tplag epdaviletol TO OVOUOTENWVUUO Tou/tng otn Aiota

Juppetexovtwy(Participants). Elvat onpavtikd ol pabntég/tpleg va mAnktpoAoyouv to
0oANBOLVO TOUC OVOUATENMWVUO TIPOKELEVOU Va elval avayvwpilolpol/eg. e mepintwon
TIOU €10€ABEL oTNV TAEN ATOUO UE KN avVAYyVWPLoIUO OVOUOTEMWVULO TPoTEelveTal va
tou/tng 600l o Adyoc yia va tautononBei rolog/mola sivat kat dv dev avVAKEL otV
taén va yivel Expel (amopdkpuvon amd tnv aibBouca) pe 6efl KAK MAvVw oOTO
OVOMOTEMWVULO TOU atopou (BA.elkova) oto mapabupo Tuppetéxovreg(Participants).

+ ALSaKTiKO cuuBoAato
Itn puotkn Tdén, katd tnv 1" SI8aKTIKA wpa Tou padApato yivetal to S8aktkd

oupBoAato. To i8lo toxVet kat yia thv 1" Stbaktikr wpa the YndLakic ta€nc. [Av dev
£€ylve, Umopel va mpayupatomolnBel petd amo Alya pobripoata.] Emonuaivovral
{NTAMATA OXETIKA HE TO TWC AOUPAVOVTAL TTAPOUCIEC/OMOUGIEG, TO XELPLOUO TWV
ULIKpodWVWY, TO va pn ylvovtal mapepacelg and yoveic otn SLapKeLla TOU LoOnpatog
(apopd pkpég NAtkisg), to otL Sev erutpenetat nxoypddnon/BLvteookomnon KA.

+ Enkowwvia

Katd tn Sidpkela tng S8aKTIKAG wpag yivetal culnTnon, Ol CUUMETEXOVTEC/OUOEG
maipvouv To Adyo KATL. AUTO ETUTUYXAVETAL E:
- Xprion pkpodwvou. Mpoteivetal va avoiyel To pHikpodwvo omotoc/a maipvel To Adyo
KoL va. TO KAglvel otav oAoKANpWVEL TNV TOoMoBETNON TOU/TNG. ZeXaopéva UKpOdwva
OVOLYTA ETUTPEMOUV VA 0LKOUYOVTOL HXOL OO TO XWPO TWV CUUUETEXOVTIWY, VOl YIVETAL
gnotpodn nxou, mapdotta KA. O/H ekmaldeuTikdg {NTAEL EUYEVIKA va KAELOOUV OL
OUUUETEXOVTEC/OUOEC TO HIKPOGWVO QpPXKA OVWVUHA R/KOL OVOUOOTIKA. J€
niepintwon mou 6ev emuiteuxBel kdtL té€tolo, umopei (o/n ekmaldeutikog) Simha oto
OVOLLOL KATIOLOU CUMETEXOVTA VO KAVEL KALK OTO TIPAGCLVO ULKpOdWwVO tou/Tng (Ba yivel
KOKKLVO Kot Oa kAeioel) A pe tnv enthoyn Mute all va k\eicouv OAa to pikpodwva. Ot
ouppeTéXovteg/ouaeg umopolv va ta Eavavoifouv. H amevepyomnoinon tng emAoyng
Allow attendees to unmute themshelves (oto uevoU Participant 1| xaunAd oto
napadupo Participants ot 3 teAsie¢ mou Pplokovral 6gfid and to Unmute all
BA.ewkdva) Sev adrivel toug/tic padntéc/tpleg va Eavavoifouv ta pikpddpwva Kat
TPEMEL vo. amodeUyeTal/xpnotpomnoteitol pe Geldw ylati «xaAdel» To madaywylko
KA{poa.
- ouvopAia (chat). O/H ekmalSeuTikog BETEL EpWTANOTA KAELOTOU TUTIOU f oUVTOUNG
amdvtnong mou amavtwvtal oto chat. Emiong, oto chat umopsl padntic/tpla va
Swatunwoel anopio, TPORANua kKA. O/H ekmoudsutikd¢ £xeL tn Suvatotnto va
anoBnkevoel To chat oe popodn apyeiou .txt (avolyel Pe TO INUELWHATAPLO) QMo TO
pevou File -> Save n File -> Save as 1| 0to TEAOG TOU HAONUATOG KATA TO KAEIGLHO TNG
Pndrakng taénc (BA.sikdva). To iSlo pmopolv va Kdvouv Kot podntég/Tpleg mou
€Xouv ocuvdeOEel LEcw AOYLOLKOU UTIOAOYLOTH).
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- XEPAKL Yl va {nTRoel padntrig/tpla to Adyo. A) Mo oluvbeon péow AoyLoHKOU
unoloylotr) PBpioketal SimAa oto Ovopa KABe OUPUETEXOVTA OTO TMapdBupo
Participants. B) Na ouvéeon péow M®uAdopetpnti(browser) umoloylotr) Bpioketal
XapnAd otig 3 tedeieg (BA.elkova). M) MNa ocvvéeon pEow KvNToL PploKeTal OTNV MAVW
6€€1a ywvia oto avBpwrdkl. Me tov (610 Tpomo mou aveBalel KAmolog/a To XEPAKL,
UTTOPEL KOl VAL TO KOTEBAOEL. SNUELWVETAL TTWG EVOEXETOL KATTOLOL/EC CUUUETEXOVTEC VOl
ONKWVOUV XEPAKL KOL VO UNV EUPAVIIETAL AUTO OTOV/OTNV EKTTAULSEUTIKO.
- yndodopia (poll).

Mna va sivar dtaBéopuo 10 mapdBupo tnc Yndodopiag, o/n ekMASEUTIKOC

erléyel and 1o pevou View -> Panels -> Manage Panels. ETUAEYEL OO apLoTEPG
Polling, kavel KAk oto kouuni Add, petadépetal to Polling otn 6€Ld otrAn Kat
XapunAd KAvel KALK 0To KouuTti OK.

O/H ekmalbeutikog €XeL etowldocsl tnv_Yndodopia mpwv thv £vapén Ttou

padnuarog w¢ £€nc: Xto mapdBupo Polling (6£€la omou epdavidovtal ta
napdabupa Participants kat Chat) kavel kA oto koupri New (BA.ewkova). AkpLBwG
ond mavw emAéyel to €ido¢ TG gpwtnong (MoAANamAng emhoyng He pia
amndvtnon, MoAAamARg emAoynG HUe TTOAAEC OMAVTIAOELG | ZUVTOUNG OmAvTnong)
KOL TILO TAVWw TAnKTpoloyel thv gpwtnon. Me to kouumi Add (BA.ewkova)
MPocBETeL TI¢ Suvatég anavtnoslg. Me To kouuni Options puBuilel tn SldpKela
™¢ Yndodopiag (my. 1 Aemto).

MOALC o/n  ekmalSeutikog  gtowudost  tnv_ Pndodopia, pmopsl: a) va

anoOnKeVOoEL TIC EpwTHOELS TG Yndodopiag and To pevou File r} amd to oXETIKO

glkovidlo tou mapaBupou Polling B) va adrost avoiyto to napabupo Polling yia
XPAON HETA amoO HEPKA AEMTA y) va avoifet maAlotepn amodnKeupévn
Pbndodopia amd to pevol File | amd To OXETKO €lkovidlo Tou mapablpou
Polling.

Mna va evepyornotiosl o/n  eknaudeutikég thv  Yndodopia yia toug/tig

CUUUETEXOVTEC, KAVEL KALK 0TO Kouurti Open Poll tou mapaBupou Polling.
Metd tnv oAokARpwon the Yndodopiag, o/n ekmadeutikog emhéyel Share with

attendees Poll results kal kavel KAtk oto koupni Apply (BA.ekévay).
Ta _anoteAéopoata tne Yndodopiacg (Poll Results) punopolv va arodnkevutouv

(kat va elval opatéG OVOUOOTLIKA OL ETUAOYECG TWV CUHUETEXOVTWY) amd TO peVoU
File. Qotooo, av anobnkeutouyv ta anoteAéopata tng Pndodopiag oto TéAog Tou
ponuatog katd to KAsiowo tng Wnodlakng tafng [OmMwe otnv mponyoupEevn
oeAiba eudaviletal oe ewova n amoBrikeuon ouvoplhiag (chat)], tote n
anoBrkevon Ba sival avwvun.

+ Albaokalia

H evepyomoinon twv podntwv/tpuv péoa omd TN OCUMMUETOXH TOUG Of
eKTIOULOEUTIKEC/ AANAETILOPOOTIKEC SpaotnploTNTEG €ival MOAU onUAvTlK o€ KABe
popdn Sidaokaiiag, akoun meplocotepo otnv € amootdoswg SdaokaAio. O/H
EKTTALSEUTIKOG UMOPEL:

A) va xpnowuomnotioel (ouviBwg péow Slapolpacpol 080vnG) EKMOLSEUTIKO UALKO
(mou OSuatiVetat kat yia thv acuvyxpovn €€ amootdosw( ekmaibsuon) amd Ta
Swadpaotika BiBAia, To PwTddevipo, Ta SLEAKTIKA oEVAPLA TOU Alowrou K.d. (BA.

gyypado |EM).
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B) va Stapolpdosl mapouvciaon i GANo apxeio/UAko kot mapAdAAnAa vo KAVEL Xpron

Tou aAAnAsrudpactikol epyaleiou Annotate.

Eival epikto va yivel Awaporpacpdg (Share): 00ovng, apyxsiov, Bivteo, acnpomnivaka

K.a. Ol avtiotolyeg emMAOYEC UTTApPXOUV a) oto pevol Share, B) otnv emthoyn Hevol

File -> Open and Share xat y) xaunAd otnv oBdovn oto kouumi Share (PA.ewkova).

Eldikotepa, Otav yivetal:
- Stapolpaocpog apxeiou. Ta mapaBupa Participants, Chat moapapévouv otabepd
oto g€l TuNpa g 006vNng Kal 0 SLOHOLPACHOG YIVETAL OTO UTIOAOLIO OpLOTEPO
TUAMA tNG 000vnG. Madntéc/tpie¢ mou E€xouv ouvbedei péow Aoyloutkou
urtoAoytoth pmopouv va anodnkeloouv To apxelo oTov UTTOAOYLOTH TOUG.
Inueiwon: Av amAd o/n ekmalSeuTikOG BEAEL va amooteilel éva apxeio (my.
dUANO epyaoiog) os paONTEG/TPLEC XWPIC Kav va KAVEL SLaOLPACUO, UMOPEL va
XPNoLpomotioeL tnv emhoyr pevol File -> Transfer kol oto véo moapdaBupo va
KAVEL KALK 0TO KOUuTti Share File yla va evtomicel kal va amooteidel To apxeio.
Madntéc/tplec rou givat os oUvEeon Uéow AoyLouLKoU UtoAoyLoTH Umopouv Vol
anoBnkevoouv To apyeio.
- Stapolpacpog 006vng. O Stapolpacuog katahappavel OAn tnv 006vn kal o/n
EKTOLOEVTIKOG MEOW TNG QVw YPOUUNG gpyaAsiwv (BA. ewkdova) sudavilel ta
napabupa Participants, Chat mou eival petakivolueva mavw otn dtapolpalopevn
006vn kal eudavidovtal w¢ ykpl TOpaAANAOypappa  OTIG 000VeC Twv
poOntwv/TpLwv.

- Stapolpacpdc Bivreo. Katd tnv évapén tou Slapolpacpol (kouurti Share) o/n
EKTIALOEVTIKOC emAéyel Optimize for motion and video (BA.ewova). e ONeC TIG
AAAEG TIEPLTTTWOELG N eTUAOYH TIPEMEL Va eival Optimize for text and images.
- Stapolpaocpdg aonporivaka. O/H ekmaldeuTikdg KAvel KALk oTo Koupri Share,
UE TN pmapa KUAlong katefaivel xapnAd otnv tedeutaia Stabéoun emhoyn Kot
Kavel KAlk oto New Whiteboard. Exel pumopel va ypael ovakowwoeLg ylo Thv
Tafn N va yivel aAAnAenibpaocn mapopola OnMwg otn Asttoupyia Annotate
(BA.mapakatw). Eivat edikto va amobnkeutel o acmpomnivakag. Mo vo oTapothost
n Xpnon oaomnpomivoka, o/n eKMASEUTIKOC KAVEL KALK OTO TAVW HMEPOC TOU
OLOTIPOTTVAKOL OTO KEVTPO OTNn AloTta SL0OE0LUWY ETUAOYWY KOL 0T CUVEXELO KAVEL
KALK oTo ARKTPO X (BA.€lkOvVal).

IN va aflomowoel (Léow Stapolpacpol 086vng) epyaleia Web2.0, rty. to Padlet wg

Tivakeg aAAnAentidpaong KATT.

Katd t™ Sldpkela tou Stopolpacpol 000vNnG-apXelwV-eKIT.UAKOU-LOTOOEAISWY KATL.,
o/n ekmoSEUTIKOC UTIOPEL VO EVEPYOTIOLAOEL KAL VA OTEVEPYOTIOLOEL TN AglToupyla
oxohlaopoU Annotate (BA.ewova). Me tn Aswtoupyia auth, eival Suvatd o/n
EKTTALSEUTIKOC/LaONTAC-TPLA VO KAVEL ETILONUAVOELC TIAVW OTO SLaPOLpa{OUEVO UALKO.
O/H pabntig/tpla {ntael (Request) mponyoupévwe to Sikaiwpa autod amod tov/tnv
EKTIALOEUTIKO, 0 oTtoiog ekywpel To Sikalwpa kavovtag KALK 0To KOUUTL Aproove.

AuTté eivan éva keipevo mou Ba xpnotpononBei wg napadsiypa yia to Slapopacuo.
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Je OMAEC TIC QVWTEPW TEPUTTWOEL, OlbaokaAiag otav yivetal Slapolpacuodg
LoTooeAbaG, ekmalSeuTikol UALKOU KATL., £ivol xpAoluo o/n eKnmoudeuTIKOC va EXEL
NPOBAEYeL yia evaAAQKTIKEG AUCELC KOL ylLO. TNV QVILLETWILON TUXOV TEXVIKWV
npoBAnudatwv. Eldotepa, ya

A) Tnv aflonoinon aAANAETSPAOTIKOU eKTMALSEUTIKOU UAWKOU. O/H eKmalSeuTIKOG
Uropel and vwplitepa va £XEL CUYKEVTIPWOEL OE apXELO KELUEVOU TOUG CUVOECHOUC Lo
Awadpaotika BipAia, Owtddevipo KA. mou Ba xpnoldomouost. And TO apxeio
KELLEVOU 0/n ekMabEUTIKOC avtlypdadel Tov cUvdeopo oto chat £tolL wote va eivat
edktd KABe padntrg/Tpla va avoiyel tov oUVEeoUo og véa KAPTEAD TTapdAANAQ Ue
Tov Slapolpacpo tng 08ovng tou/Tng ekmatdeutikol. ITnV mepintwon mou divovtal
ouvbeopol LoTtooeAidwy oto chat xpeldletal MPoooxn OXETIKA LLE TO AV 0 GUVOEGHOG
ovAKeL o Sktuako tomo tou YNAIO. Madnthic/tpta mou ouvbéeton pe Swpeav
dedouéva kat xpnoiuonolei ocuvdEououg o€ SIKTUAKOUG TOTOUG mou SEV AVviKOUV OTo
YIAIQ, da éxeL avadoyn xpéwon dsbouévwv.

B) tnv avtpetwrnion TEXVIKWV TpoPAnpdtwy. O/H ekmoldsUTIKOG TIOU KAVEL
Slopolpacpod o0Bdvne kat delxvel my. to Stadpaotiko BiBAlo, pumopel va mpoteivel TV
avtiotolyn oeAida tou évtumou oxoAlkoU eyxelpldiou oe pabntri/Tpla mMou Adyw
TEXVIKOU TIPOoPARUaTog Sev BAEMEL TOV SLALOLPOGLO.

+ Epyaoia og opddeg
YTdpxouv oL apakATw SuvaTtoTnTEC:

- Xwplopog twv padntwv/tpuwyv os opddeg epyooiag mou cuvepyalovial HECA OF
empépoug Pndlaka dwuatia tov Webex Meetings. H Asitoupyia xwplopol o€
opadeg evepyormoleital and tnv emnthoyr| Levol Breakout -> Enable Breakout Session.
H xpnon tng¢ duvatdotnrog outAg OCUVOEeTal HME TO KivATpo/wpLuotnTa Twv
EKTIALOEVOUEVWV KaL TIG SEELOTNTEC AUTOPPUBLLLONG TTIOU £XOUV QVATTTUEEL.

- Yrnootnpin Héow SpaoctnplotnTwv oouyxpovng €€ amootdoewg eskmaibsuonc.
MmopoUv va TpayHaTonolnfoUv CUVEPYATIKEG SPaoTNPLOTNTEG MOU MEPLEXOVTAL
otnv eclass f§ otnv e-me.

- Aflomoinon ouvepyatikwv eyypddwv Ttou MZA otov cUvdeopo http://grafis.sch.gr/

+ AgloAbdynon

- Katd tn xprion meptBal\oviwv clyxpovng emkowwviag/alnAenidbpaong ty. Webex
Meetings 6ev guvoeitar n aloAdynon HEOW EPWTACEWV YVWOEWV. Mrmopoulv va
SLOTUTIWBOOUV EPWTALATA TTOU ATTALTOUV KPLTLKA LKAVOTNTA, EPOPHOYH YVWOEWV KATL.
- H afloAoynon unootnpidetal os peydho Babuod amodé Spactnplotnteg acuyxpovng &€
onmootaoewC eknaibsuong pEéow twv neptBaAloviwy eclass i e-me.

- Katd tn Stdpkela tou padriuatog pe to Webex Meetings padntig/tpla propei va
napouoldcel gpyacia Siapoitpalovrag thv 006vn tou/tne. Ma va yivel auto, o/n
EKTTALOEUTIKOC KAvel g€l KALK OTO OVOMOTEMWVUMO Ttou/tng padnth/tplag oto
napabupo Participants kal emiAéyel Change Role -> Make Presenter To JKPO UMAe
£1kovidlo tou Webex peTakwveitol amd to Ovopa Tou/tng eKMaldeuTIKOU 0To dvoud
tou/tng padnth/tplag (BA.ewkova). O/H pabntig/tplta amoktd tn Suvatotnta
Swapolpacpol. Otav olokAnpwBei n mapouvciaocn Ttou/tng padnthi/tplag, o/n
eKTIOULOEUTIKOG KAveL g€l KALK 0TO SIKO TOU/TNG OVOUATENMWVUHO Kat eTithéyel Change
Role -> Make Presenter ylLa va amoktrioeL Eava to Sikailwpa mapoucioonc.
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- Katd tnv avabeon epyaclwv yla TO OTITL €ival Xprowwo o/n ekmabeUTIKOS va
AauBavet urtoyn to ouvoAiké xpovo rou Bpioketal o/n HadNTHC/TPLA UTPOOTA OE
pia 090vn (6-7 WPEG TNV NUEPA yLa TNV TTOpakoAouBnon Twv pabnuatwv). MNpdobeteg
gpyooisc avédvouv tov Adn peydAo xpovo mou Ppiokovral podnTtég/TpLeg UMpooTd
otnv 00ovn.

- H emkowwvia skmatdsvutikol/padntr-tplag yivetatr Pndlakd, ald outd bev
UTIOXPEWVEL OAEC OL OXOAIKEG Spaotnplotnteg va yivovtal Pndlakd. Téoo Katd tn
Sldpkela Tou oUyxpovou pabnuatog pe to Webex Meetings 600 kol wg avaBeon
gpyooiag (mou vloroteital aclyxpova), ot padntég/tpleg sival epktd va Kdvouv
Spaoctnplotnta Pndrakd | oe évtunn popdn, my. cuyypadn 1-2 mapaypadwv mou
umopel va yivet:

a) Pndlaka péow tou Yndlakol meplpdiiovtog eclass/e-me/Padlet kAm. n/kal oe
cuvluaoUO UE TN XPrion AoyLopLKoU enefepyaciog KELWEVOU

B) og évtumn popdn oto TeTpadio Tou/Tng padbntr/TpLag, Omou to TeAKO Keipevo eite
ETOELKVUETAL OTNV KAMEPA KATA TO oUyxpovo padnua eite ¢pwtoypadiletal Kat
avaptatal PnoLoka.
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2T CUVEXELQ TIEPLYPAEQOVTAL CUVOMTIKA Midavd TEXVIKA MPoBARuATa Kol TPOTELVOUEVOL TPOMOL

QVTILUETWITLONG TOUC.

4+  AVTLUETWILON TILOAVWV TEXVIKWV TtpoBARUATWY

- H mowotnta tng olvdeong kAbe ekmaldeutikoU Kal KaBe pabntn/tplag e€aptartatl
oTO: TO TEXVIKA XOPOKTNPLOTIKA TOU UTOAOYLOTH) LIE TOV Omoio ouvdéBnke, tnv
tayvtnta t¢ ouvdeong oto Aladiktuo, tov GOpTo TWV ypapUWwV AladLKTUOoU, TIG
KOUPIKEG OUVONKEG KATL. Amatteitow KaAUtepn/Toxutepn ouvéeon Otav avoiyouv
Kauepeg, yivetat dlauotpacuos odévneg/apyeiov i tpoBoAn Bivreo.

- Y& éva omolodnAmote pabnua av kamowog/a v akoUyetal pumopei va £XeL §exAoel
KAELOTO TO PUKpOdWVO. Av Kamoloc/a padntic/tpla éxet texvika npoPAnRpata (my. Sev
akoUeL kaBapad), kalo elval va KAelogL TRV KApepa (Tou emPapuvel Tnv ocLVEEDN) Kal
va favadokiuaoel. Av dev AUvetal to TpoPAnua, va Byel and tnv Pndlakn tagn
(matwvtag KAtw To KOKKLVO X) Kot va §avaouvSeBel (svoéxetal va AuBei to mpdpAnua)
KOl TEAOG, VO SOKLUAOEL va UMEL amd GAAN cUoKEUN av UTIAPXEL. [ELSIKA yLa TNV pwTn
dopa ouvdeong, av kamolog/a Sev €xel Axo Ba TpEmel va eAéy€el av Aettoupyouv
Ukpodwvo/nxeia, TIg avtioTolXeg puBUIoELS KATL.]



